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The attached assignments will provide instruction in properly setting tabs and indents in Microsoft Word. 

· TABS

Tabs are used for moving along a horizontal line without using the space bar.  You have already used tabs for indenting the beginning of a paragraph.  Tabs are automatically set every half-inch on a horizontal line.  A mark has been placed at each of the automatic tab settings – notice that it corresponds with the ruler bar.
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You can decide where you want to place a tab.  Tabs can be set anywhere along the ruler bar.

· LEADERS

Leaders are dots that are used to keep your eye following on the correct line of text when you have a page with information on the left and right side, but no information in the middle.  Your computer is automatically set for NO LEADER.  Below is an example of a leader:

Potato Skins
$4.95

· INDENTS

Indents are used to when you want to include a lengthy quotation from a book or article.  They can also be used when typing items such as footnotes or bibliographies.  When properly set, paragraph indents can save lots of time and keystrokes.  
Directions:

1. Complete each assignment by following the directions.

2. Complete assignments in the order given.

3. Save to your student number
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EXERCISE 1 -TABS EXERCISE

In the following exercise you will practice setting tabs with various alignments and leaders.

Directions:  Type the following in COURIER NEW, size 12.  Follow directions carefully for setting tabs.  MAKE SURE YOU READ THE DIRECTIONS CAREFULLY!!!

Type your name, the hour and date using a header.

1. Set a 6 inch right aligned tab.  Press tab and type your first and last name.  Press enter three times.


2. Clear all tabs.  Set a 1.7 inch left aligned tab.  Press tab and type the words Eighth Grade.  Press enter three times.


3. Clear all tabs.  Set a 2 inch center aligned tab.  Press tab and type the words Rockwood School District.  Press enter three times.


4. Clear all tabs.  Set a 2.5 inch left aligned tab.  Press tab and type the words Selvidge Middle School.  Press enter three times.


5. Clear all tabs.  Set a 6 inch decimal tab using a #2 (dot…) leader.  Type the words Deluxe Cheeseburger and then press the tab key and type $5.99.  Press enter once and type French Fries and then press the tab key and type $2.49.  Press enter three times.


6. Clear all tabs.  Set a 3 inch center aligned tab.  Press tab and type THE END.


7. Is your font style COURIER NEW?  Is your type size on 12?


8. Save as TABS using your student number.
Proofread, spell check, print and attach to the other exercises you will complete.

EXERCISE 2 – ALIGNING TABS
Directions:  

1. Type your name, hour and date using a header.  

2. Use font size 12.  

3. Set your line spacing on 1.5 lines (Format>Paragraph>Line Spacing)

4. Type the main title centered, bolded and in ALL CAPS.  Press Enter
5. Type the sub title (In Millions) centered, bolded, and in Title Case.  Press Enter
6. Click on Align Left
7. Set the following tab stops (Format>Tabs).   Click the SET button after each one.

· Center Align Tab at 3 inches

· Decimal Tab at 6 inches
· Type the Column Headings on bold and underline.

8. Turn off bold and underline and type the information in the table as shown.
9. Add two clip art pictures that relate to movies.  Place one on each side of the title.
10. Save as Movies on your student number.  
11. Proofread, spell check, print and attach to the other exercises you will complete.

ALL TIME TOP GROSSING FILMS
(In Millions)

Rank 
Title
Gross Sales

1
Titanic
$600,788,188.33

2
Star Wars: Episode IV
$460,998,007.12


3
Shrek 2
$437,212,000.00


4
E.T. The Extra Terrestrial
$434,974,579.45


5
Star Wars: Episode I
$431,088,301.58



6
Pirates of the Caribbean
$423,032,628.19


7
Spider Man
$407,681,000.00


8
Star Wars: Episode III
$380,270,577.03


9
The Lord of the Rings
$377,019,252.43


10
Spider Man 2
$373,377,893.98


11
The Passion of the Christ
$370,773,867.77


12
Jurassic Park
$356,784,000.00

EXERCISE 3-TABS AND LEADERS

1. Make sure a new, blank document window is on your screen.

2. Type your name, the hour and date at the top of the page using a header.  (View>Header & Footer)

3. Set a Left tab at  .5”
4. Set another Left tab at 2” with a Dot Leader (#2 under the leader section of the Tabs Dialog Box).

5. Finally set a 5.5” Right Tab with a Dot Leader (#2 under the leader section of the Tabs Dialog Box).

6. Center and bold the title—BILLBOARD’S TOP 15 HITS
7. Change the type size to 24 for the title only. 

8. After typing the title, press Enter twice.

9. Change the type size back to 12, click on left align, and turn off bold.
10. Change the spacing OF THE TABLE ONLY to Double Spacing. 

(YOU SHOULD NOT HAVE MORE THAN ONE OR TWO BLANK LINES 
    BETWEEN THE TITLE AND THE TABLE.


11. Change the font of the entire table, including the title to Arial Narrow.  Change the font color to Dark Blue.
12. Enter the following information.

BILLBOARD TOP 15 HITS

1
Big Girls Don’t Cry
Fergie

2
The Way I Are
Timbaland

3
Hey There Delilah
Plain White T’s


4
Beautiful Girls
Sean Kingston


5
Stronger
Kayne West


6
Wait For You
Elliott Yamin


7
Who Knew
Pink


8
Me Love
Sean Kingston


9
Rockstar
Nickelback


10
Shut Up And Drive
Rihanna


11
When You’re Gone
Avril Lavigne


12
Make Me Better
Fabulous


13
Summer Love
Justin Timberlake


14
Makes Me Wonder
Maroon 5

15
What Time Is It
High School Musical Cast

13. Add one picture that relates to the information in the table.  Place it to the left of the title.
14. Save the document as BILLBOARD using your student number.

15. Proofread, spell check, print and attach to the other exercises you will complete.

EXERCISE 4-PARAGRAPH INDENTS

DIRECTIONS:  In this exercise you will learn to format paragraph indents.  You will have four different types of indents.  1.  First Line Paragraph indent, 2.  Left indent, 
3. Double indent (left and right indent), 4.  Hanging indent.  
· Type your name, hour and date at the top of the page using a header

· Retype each paragraph as it appears (including the proper indent.)  

· Change the font to Courier New.  Change the type size to 12.

· Press enter twice times at the end of each paragraph.

· Reminder:  To set an indent, click format>paragraph>and then go to the indentation section and make your selections.


When typing a first line paragraph indent, it is just like pressing the tab key to begin a paragraph.  The first line begins farther to the right and all other lines in the paragraph start at the left margin. 

An example of a paragraph with a left indent is when all lines in the paragraph are moved inward and away from the left margin. 

This is a left and right (or double) paragraph indent. Each line of the paragraph is indented from both the left and right margins. They are good to use when typing quotes.

After typing the above paragraphs, clear your indents and then type the last paragraph.

This paragraph demonstrates a hanging indent.  Here, all lines except the first are moved away from the left margin. Use a hanging indent when typing bibliographies. 



Use spell check 

Save as INDENTS using your student number.

Proofread, spell check, print and attach to the other exercises you will complete.

EXERCISE 5-USING TABS AND INDENTS

DIRECTIONS:   FOLLOW EACH STEP…DON’T SKIP ANY!!! (

1. Begin by placing a header with your name, the hour and the date. Close the header.

2. Click on center alignment.  

3. Type E M A I L   M E M O (include one space between each character and three spaces between each word), then press enter three times.

4. Change to left alignment.

5. Set a right tab at the 1-inch position and a left tab at the 1.3-inch position.

6. Type the first four lines using both tab settings to align the entries.
A.  Press Tab and type TO:
B.  Press Tab again and type All Kids 12-17 Years Old
C.  Press enter.
D.  Repeat the above steps for the FROM, DATE, AND SUBJECT lines.

7. Press enter twice.

8. Set a left paragraph indentation of 1.3 inches (THIS IS NOT A TAB SETTING!!!)

9. Type the rest of the document as shown below using the left paragraph indent setting and pressing Enter TWICE at the end of the each paragraph.


TO:
All Kids 12-17 Years Old

FROM:  
The Nabisco Corporation

DATE:  
April 14, 200X


SUBJECT: 
Yard Ball
Nabisco’s Bubble Yum has signed on as the first official bubble gum of Major League Baseball and this season is sponsoring a national bubble gum chewing contest and developing a tournament called, “Yard Ball”.
This two-year deal includes updated packaging designed to give Bubble Yum the edginess of its biggest rival Bubblelicious.  Bubble Yum will put MLB logos on the outside of 100 million packages.  Plans are also in place to sponsor a national bubble gum blowing contest as well as a three on three wiffel ball tournament called, “Yard Ball” that will kick off at this year’s All Star Game.
Watch for upcoming details!

Spell check the document.

SAVE the document as Bubble using your student number.
Proofread, spell check, print and attach to the other exercises you will complete.

EXERCISE 6-PARAGRAPH INDENTS AND QUOTES
In this exercise you will use a double paragraph indent to indicate a quotation.  

Directions:

1. Open a new document in MS Word.

2. Type your name, the hour, and the date as a FOOTER. 

3. Leave the font on Times New Roman

4. Change the line spacing to Double.

5. Type the document shown below following the directions in each text box


SEARS CATALOG

Richard Warren Sears was born in a railroad station in Minnesota in 1886.  Many years later he returned to that same railroad station as a stationmaster and telegraph agent.  To get more money, he started peddling watches.  His part-time business was so successful that he quit his railroad job and started his own watch company in Minneapolis.  One historian describes Sears this way:
“His presence reminded you of a minister.  He was tall, extremely thin, and always wore a black suit with a high standing collar and a black bow tie.    He knew how to advertise and promote his product.  He showed up each morning with his pockets bulging with ideas he had scribbled on bits of paper.”
· Spell check the document.

· Save as SEARS using your student number.
· Proofread, spell check, print and attach to the other exercises you will complete.
USING TABS AND INDENTS





FORMATTING TIPS TO REMEMBER:





TO SET TABS:


Click Page Layout Tab


Click Paragraph Group Launcher (arrow)


At the bottom of the Paragraph dialog box click TABS


Type in desired inches for tab


Choose an alignment (There are 4 choices)


Click SET


Click OK








THERE ARE 4 ALIGNMENTS FOR TABS:


Left Align


Right Align


Center Align


Decimal Align





RIGHT ALIGNED


This is an example


Of a right aligned tab


Everything is at


The right side











LEFT ALIGNED


This is an example


of a Left-Aligned


Tab.  Everything


Is at the 


Left side.





DECIMAL ALIGNED


This is an 	5.50


Example of a 	.45


Decimal-aligned	100.00


Tab.  Every tab is	25.00


Lined up at the	.65


Decimal point.





CENTER ALIGNED


This is an example


Of a Center-Aligned


Tab.  Every line is 


Centered.





LEADER ALIGNED


This is an example	Hi


Of a leader	Hello


Aligned tab	Howdy





EXAMPLE:


Menu item	Price





PARAGRAPH INDENTS


Click Page Layout Tab


Locate Paragraph Group Launcher


In the Indentation section, change indent to the desired inches in the Left or Right indents �OR �Choose First Line or Hanging from the Special drop down menu





Your table will not look exactly like this.





Your table will not look exactly like this.





1” left indent





1” left and right indent





All lines should “line up”





Title: center, type size 12, bold





Left align 1st Paragraph 





Use justified alignment for the paragraph indent and single spacing





1” left and right paragraph indent.








